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Notice

Information contained in this document is believed to be accurate and reliable at the time
of printing. However, due to ongoing product improvements and revisions, AudioCodes
cannot guarantee accuracy of printed material after the Date Published nor can it accept
responsibility for errors or omissions. Updates to this document can be downloaded
from https://www.audiocodes.com/library/technical-documents.

This document is subject to change without notice.

Date Published: August-18-2022

WEEE EU Directive
Pursuant to the WEEE EU Directive, electronic and electrical waste must not be disposed of with
unsorted waste. Please contact your local recycling authority for disposal of this product.

Customer Support
Customer technical support and services are provided by AudioCodes or by an authorized
AudioCodes Service Partner. For more information on how to buy technical support for
AudioCodes products and for contact information, please visit our website at
https://www.audiocodes.com/services-support/maintenance-and-support.

Documentation Feedback
AudioCodes continually strives to produce high quality documentation. If you have any
comments (suggestions or errors) regarding this document, please fill out the Documentation
Feedback form on our website at https://online.audiocodes.com/documentation-feedback.

Stay in the Loop with AudioCodes
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1 Introduction
AudioCodes Voca is designed to provide an innovative, next-generation service experience for
users interacting with company Workers, Agents and internal business lines using modern
Behavioral Routing and Conversational AI technologies.

By combining Voice.AI, IVR and Voice Networking, the Interaction Center solution by
AudioCodes features an advanced multi- language Conversational AI interface that instantly
automates IVR flows by using simple, intuitive voice requests over natural language, providing
robust support for a variety of Conversational IVR, Auto-Attendant flows and Self-Service use-
cases.

Coupled with Voca’s Conversational capabilities, the application also includes an intuitive No-
code Flow Designer, dedicated Worker (Agent) and Supervisor experience, CRM integration,
Skill-based routing, Real-time Dashboards and a set of Historical Reports, providing customers
with a complete all-round Interaction Center solution.

With flexible deployment and connectivity models, Voca can integrate with any PBX, Contact
Center or UC platform, allowing customers to manage CC, IVR, Auto-Attendant and Call Queues
in one centralized multi-tenant application that serves multiple voice platforms in parallel. The
solution is GDPR compliant and available for quick deployment from zero-to-service in just a
few days.
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2 Getting Started
There are a number of ways to install the Voca system:

■ Clean Windows Installation: A customer provides a clean-installed Windows 2016/2019
system with the latest security updates. The installation will be provided by AudioCodes as
a downloadable URL.

■ AudioCodes Mediant 800 Installation: AudioCodes provides a Mediant 800 with a pre-
installed Windows 2016. The installation package will be located at C:\ACVoca_Installer.

■ Pre-installed: AudioCodes offers Voca Software as a Service (SaaS) as a cloud deployment.
Please contact your AudioCodes representative for more information on this option.

The default Administrator's password is "Pass123". It is highly recommended to
change the password according to the Enterprise's policy. The updated password
must be stored in a secure location, so that it is accessible to those that need to it.

Hardware and Infrastructure Requirements
Voca is available either as a Cloud (AWS or Azure) deployment, or fully deployed On-Premises
over virtual machines.

The following describes the hardware and infrastructure requirements.

Hardware Requirements

On-premises Installation

To support up to 50 Concurrent voice recognition channels and 140 Concurrent DTMF channels,
the Voca server requires the following minimum hardware configuration (not including SBC):

■ CPU: Intel Core i7-5th Gen @ 2.7GHz with 4 cores or higher (Hyper-threaded cores – total
of 8 logical cores).

■ RAM: 32 GB

■ SSD: 256 GB - C (at least 100 GB) and D partition

■ NIC: 1 GB Ethernet card with static MAC address (For Hyper-V installations, configure the
MAC address using the Advanced Features option.)

■ Operating System:Windows Server 2016 or 2019

To support up to 40 Concurrent voice recognition channels and 100 Concurrent DTMF channels,
the Voca server requires the following minimum hardware configuration (not including SBC):

■ CPU: Intel Atom® Processor C3758 16M Cache, up to 2.20 GHz

■ RAM: 16 GB

■ SSD: 256 GB - C (at least 100 GB) and D partition
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■ NIC: 1 GB Ethernet card with static MAC address (For Hyper-V installations, configure the
MAC address using the Advanced Features option.)

■ Operating System:Windows Server 2016 or 2019

To support Hebrew language for On-premises deployments, the processor must at
least support AVX2 and FMA features.

Private Cloud Installations

Voca server requires the following minimum hardware configuration per the selected cloud
environment:

■ AWS: c5.2xlarge instance or higher

■ Azure: Standard F8s instance or higher

■ For other configurations: Contact your AudioCodes representative

To enable Voca to use speech recognition via Azure Cognitive Services, you must
verify the Internet connectivity between the Voca server (On-premises or Cloud) to
Azure Cognitive Services.

Self-installation is designed to support single-tenant deployments. For multi-tenant
deployments, contact your AudioCodes Sales or Technical Support representative.

Infrastructure Requirements

For Interaction Center deployment, customers must have an Active direct routing
environment that includes the following:
● Direct routing SBC connected to Microsoft Teams tenant
● Teams users with phone numbers
● Voice Mail feature for Teams users, that use the Voca Conversational Interaction

center MUST be disabled

When Media Bypass is enabled on the organization level (i.e., Teams tenant and
SBC), the organization's Administrator must open the following ports and protocols in
the organizational firewall:
● FromMicrosoft ACS (20.202.0.0/16) to the customer's SBC network UDP 3478 -

3481
● FromMicrosoft ACS (20.202.0.0/16) to the customer's SBC network UDP 6000-

10000 (SBCMedia ports)
● FromMicrosoft ACS (20.202.0.0/16) to the customer's SBC network UDP 9580-

9585
● FromMicrosoft ACS (20.202.0.0/16) to the customer's SBC network TCP Port

443
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On-premise and Private Cloud Deployment

To support languages based on Azure Cognitive Services, the Voca server must have
connectivity to the following URL’s using TCP Port 443:

■ *.cognitive.microsoft.com

■ *.cognitiveservices.azure.com

The following items should be addressed to enable the Interaction Center functionality:

■ Security Rules

The organizational Administrator should allow:

● HTTPS connectivity (Port 7204) from the On-Premise Voca server to *.audiocodes.io

● HTTPS connectivity (Port 443) from the On-Premise Voca server to *.cloudapp.net

● HTTPS connectivity (Port 8443) between the agent desktop clients network to the Voca
server

■ DNS

● The Administrator should create an internal DNS for
“workerapp.vocainteractioncenter.io" that should point to the Voca server.

■ Consent

● The organization Administrator (Microsoft 365) should grant tenant-wide admin
consent to the agent application on behalf of the organization.
Use the following link to grant consent (replace {Tenant_ID} with the organization
Azure Tenant ID): https://login.microsoftonline.com/{Tenant_
ID}/adminconsent?client_id=77f087b6-9731-4bb7-a6fa-7d3d0bccd725

AudioCodes Cloud Service Deployment

The following items should be addressed to enable Interaction Center functionality:

■ Security Rules

The organizational Administrator should allow:

● HTTPS connectivity (Port 8443) between the agent desktop clients network and the
Voca Cloud *.audiocodes.io.

■ Consent

● The organization's Administrator (Microsoft 365) should grant tenant-wide admin
consent to the agent application on behalf of the organization.
Use the following link to grant consent (replace {Tenant_ID} with the organization
Azure Tenant ID): https://login.microsoftonline.com/{Tenant_
ID}/adminconsent?client_id=77f087b6- 9731-4bb7-a6fa-7d3d0bccd725

System Capacities

The Voca server supports the following channel capacities:

- 4 -



CHAPTER 2    Getting Started Voca | Installation Manual

■ For On-premises implementations based on Virtual Machine (VM):

● 20 concurrent ASR sessions for Hebrew

● 50 concurrent sessions for all other languages (via Microsoft Azure Cognitive Services)

■ For Cloud implementations:

● 30 concurrent ASR sessions for Hebrew

● 50 concurrent sessions for all other languages (via Microsoft Azure Cognitive Services)

Entries Support
■ Up to 20,000 entries

Using Clean Windows Installation
It is the customer’s responsibility to provide a clean-installed licensed Windows 2016/2019
system with the following requirements:

■ .NET Framework Features 3.5

If the server has Internet connectivity during installation, the framework will be
installed automatically. Otherwise .NET 3.5 should be pre- installed (see Enabling
.NET Framework 3.5 on Windows on page 57).

■ Disabled Virtual Memory paging file

■ Latest security updates

■ Static IP address

■ Disk Partitioning

The hard disk should be partitioned to the C:\ and D:\ drives.

■ Chrome or Microsoft Edge (chromium-based)

Additional Software Installation

The user must not install any additional software on the server, including anti-virus or any real-
time scanner. Installation of any third-party software may lead to performance issues, stability
problems and may cause unpredictable results.

Disabling Virtual Memory Paging File

The procedure below describes how to disable the Virtual Memory Paging file.

➢ To disable Virtual Memory Paging File on a Windows System

1. Press the Windows key and open Control Panel.
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2. Navigate to System and Security > System, and then click Advanced system settings in the
left pane.
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3. In the System Properties dialog box, click the Advanced tab, and then click Settings…
under the 'Performance' group.

4. Click the Advanced tab, and then click the Change… button.
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5. Clear the 'Automatically manage paging file size for all drives' check box.

6. Select the drive that it is on, and then click the No paging file option.
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7. Click Set, and then click OK.

8. Select Restart Now to apply the changes.

Using AudioCodes Mediant 800 Installation
Before installing the Voca system on AudioCodes Mediant 800, do the following:

■ Install Windows 2016/2019 Security Updates

■ Configure the OSN IP address

■ Configure the Server System Time Settings

Installing Windows Security Updates

Install Windows Security Updates to run the latest service patches and install all missing
updates.
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Configuring the OSN IP Address

The Voca system must have a static IP address. You can configure a static IP address for the
OSN server on the Mediant 800.

If you are connected remotely, performing this step will disconnect you from the
system. After performing this step, you can re-connect the system with its new
location and IP address.

➢ To configure a static IP address for OSN:

1. Press the Windows Start key.

2. Open the Network and Sharing Center (Control Panel > Network and Internet > Network
and Sharing Center).
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3. Right-click the Intel(R) Ethernet Connection I217-LM network connection, and then from
the shortcut menu, select Rename.

4. Assign the new alias name as Internal.

5. Right-click the Internal network connection, and then from the shortcut menu, choose
Properties.
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6. Double-click Internet Protocol Version 4 (TCP/IPv4).
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7. Enter the IP address and DNS server addresses.

8. Click Advanced.

9. Clear the 'Automatic Metric' check box, and then in the 'Interface Metric' field enter "1".
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A low metric number indicates higher priority. A high metric number indicates low
priority.

10. Click OK to apply the configuration.
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11. Click OK to close the Internal Properties window.

12. Close the Network Connections window.
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3 Installing Voca
The procedure below describes how to install Voca. As noted in Getting Started on page 2,
there are a number of ways to install the Voca system.

Copy the installation files to the C:\ACVoca_Installer directory.

A restart may be required during installation. After the restart has completed, log in to
the server and the installation process will continue automatically.

➢ To run pre-installation in case of upgrade:

1. Backup the recent systems data.

a. The backup procedure will be performed automatically by the Voca installer. The
backup directory is C:\NSC\Backup_<Time Stamp>\BackupFiles\.

b. It is highly recommended to save the:

◆ licenses files in C:\NSC\License\ directory

◆ SBC configuration files in C:\NSC\SBCconfig directory

These and other important Voca directories will be backed up during the upgrade or
during the daily scheduler backup procedure.

2. If the LDAP standalone synchronization feature is used:

a. Un-install the old VocaEnterpriseDirectoryService.

b. Open the VocaNOM Directory Client
C:\NSC\LDAP\VocaLdapService\VocaLdapSetup.exe.

c. Click Stop service.
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d. Click Configure.

e. Click Configure.

f. Click Uninstall Service.

g. Close the VocaNom Directory Client.

h. Rename the 'C:\ProgramData\VocaLdapService\Settings.xml' file
to 'settings_bak.xml'.

3. If the CSV synchronization feature is used:

a. Backup CSV synchronization files located under C:\NSC\LDAP\Import_CSV_to_Cloud

b. Restore the feature after the upgrade.

4. Upgrade Voca Version 8.0.1.

The upgrade procedure fails when you try to upgrade Voca Version 8.0.1 (primary or
secondary) to Voca Version 8.4.0 (primary or secondary). This issue did not occur during
upgrading Voca Version 8.0.1 (standalone) to Voca Version 8.4.0 (standalone). See
Upgrading from Voca Version 8.0.1 to Voca Version 8.4.0.htm.

5. Upgrade Voca Version 8.0.2.
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During the upgrade of Voca Version 8.0.2 to Voca Version 8.4.0, the Enghouse CTIC (Media
Gateway) application is removed by installer.

Backup the CTIC (Media Gateway) license before you run the upgrade procedure.
The license can be found in C:\Program Files (x86)\Enghouse Interactive\CTI
Connect\Licenses.

See Installing Enghouse CTIC (Media Gateway) application in Enghouse CTIC directory.

6. Restart the server.

➢ To install Voca:

1. The Windows Update service must be stopped and disabled during the Voca installation. It
can be enabled once the Voca installation procedure has been completed.

2. Right-click the ACVoca installation file, and then select Run as Administrator.

3. After launching the installer, the installer UI appears. You need to configure the installation
process.
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4. The End user license agreement appears; click Next.

5. Select which features you want to include in the installation, and then click Next.

6. Select the languages you wish to install, and then click Next.
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The Spanish dialect is supported in GMMmode only.

7. The AudioLogs directory window appears. The Voca system records and saves the speech
request in an audio logs directory. Assign the D:\AudioLogs directory, and then click Next.

8. From the ASR drop-down list, select the ASR component. As noted above, the Spanish
dialect is supported in GMMmode. Select your choice accordingly, and then click Next.
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9. If Web Core was selected for installation, you need to select the type of DB:

● Standalone

● Primary

● Secondary

10. Select Primary or Secondary if your installation is part of a High Availability setup.

11. In the 'Traffic IP' field, enter the traffic IP used for SIP; in the 'Web IP' field, enter web IP
used for admin management and the DB.
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12. During the initial installation, enter a new password for the Voca User. In case of an
upgrade, enter the existing password. Click Next to continue.

13. The Information page appears; click Continue.
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14. On the Ready to Install page, click Install. The installation process begins.

15. The installation progress bar appears.
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16. When completed, the installer displays the following screen. Click Restart to restart the
server.

17. Restart the server.

Changes will not take effect until you reboot the system.
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Running Post-Installation
The procedure below describes how to run the post-installation procedure when performing an
upgrade.

➢ To run the post-installation when performing an upgrade:

1. Recompile the grammars.

a. Recompile contacts and departments grammars.

b. Recompile the periphery’s grammars.

i. Open the command line as an Administrator.

ii. Run the following commands:

>cd C:\NSC\NSC_AA\<dialect>\Grammars\Compile\compile_dnn\

>CompileGrammars_HB.bat

Version 8.0.1 or later is released with Amazon Corretto Java engine Version
11.0.9.12.1. In case of available security patches for Version 11.x, the installed java
engine can be updated.

2. Reconfigure Music-On-Hold if required.
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4 Upgrading Voca
When upgrading Voca, refer to the upgrade notes in Installing Voca on page 17.

The following items should be addressed during system upgrade:

■ System backup

■ LDAP or CSV synchronization migration

■ Installing new Voca licenses

■ Grammar recompilation

■ Setting up Music on Hold

Voca Versions that can be Upgraded
The following Voca versions can be upgraded:

■ Version 8.0.2

■ Version 8.4.0
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5 Configuring Enghouse Interactive Communication
Portal (CP)
Enghouse Interactive (CP) is a third-party application responsible for SIP connectivity between a
customer's PBX and the Voca speech recognition agent.

➢ To configure Enghouse Interactive’s CP:

1. Launch the CP Console 10.3.

2. When prompted to set a password, select the 'I don’t want to use…' check box, and then
click OK.

3. When the configuration wizard starts, click Next.
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4. When prompted, enter the password AC123456.

5. Click Finish when the configuration completes.
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6. Configure ReadSpeaker TTS support; on the right pane open MRCP_TTS and assign the
following settings:

7. Configure the software channel; it should be applied for Skill-based Routing Queue feature
support. Do the following:
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The software channel is limited by the Enghouse Control Panel license. Add the
software channel when you send the license request.

a. Install the Enghouse Control Panel license with software license support (see Installing
Enghouse Interactive License ).

b. Open the Enghouse Control Panel.

c. Right-click on the software channel, and then click Open.

d. Select CallQueueNotify-HTTPListenner, and then click Load.

- 31 -



CHAPTER 5    Configuring Enghouse Interactive Communication Portal (CP) Voca | Installation Manual

e. Right-click on the software channel, and then click Channel Start.

The software channel starts.
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6 Installing Voca License
AudioCodes provides a license to use Voca. You can obtain a "finger print" file from the server
that you want to install Voca on. This file is sent to AudioCodes so that a license file can be
created and sent back to the customer.

● All licenses have virtual machine clone protection. If there is any change inthe
Virtual MAC address, CPU characteristics or UUID, the license protection
procedure is enabled and you will need to repeat the licensing process.

● After you upgrade to Version 8.0.1 or later, you need to issue and re-install the
Voca new license. Enghouse and TTS software licenses are not affected by the
upgrade.

➢ To install the Voca License:

1. Log in to Voca by navigating to https://<IP Address> in your Chrome browser.

2. To get the Administrator credentials, please contact your AudioCodes representative.

The default Administrator credentials should be modified after installation.
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3. On the Licensing page (Configuration > Licensing), click Get finger print. A finger print file is
created on your server.

This is a sample finger print file:

4. Send the finger print file to AudioCodes.

5. When you have received your License file from AudioCodes, copy it to your server.

6. Click Choose File to select your license.
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7. Select the license file name, and then click Open.

8. In the Set License window, click Set license to activate your Voca license.

9. After you have set the license, the total number of licenses should be displayed on the
screen.
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This is an example of what a license file looks like.

After you upgrade to Version 8.0.1 or later, you need to issue and re-install the new
Voca license.

➢ To install the Voca License after upgrade:

1. Navigate to http://127.0.0.1:1947 on your Chrome browser.

2. Click Sentinel Keys.

3. Send the Key ID number for the local server to AudioCodes.

4. When you have received your License file from AudioCodes, copy it to your server and
apply the Voca license using the Voca Web interface (License.htm).
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➢ To install the Voca License after virtual machine cloning:

1. Clean the cloned license by removing the old V2C file.

a. Stop Sentinel LDK License Manager service.

b. Open C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel
LDK\installed\94011 and remove all V2C files.

c. Start the Sentinel LDK License Manager service.

2. Repeat the license procedure (see Installing the AC Voca License.htm)
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7 Installing Third-Party Licenses
In addition to the previous section that explains how to install the Voca license, you must also
install the Enghouse Interactive license and a relevant Text to Speech license. This section first
describes how to install Enghouse Interactive licenses. Once you have completed this
installation, you must then install and configure an appropriate Text to Speech license.

Installing Enghouse Interactive License
You can install the Enghouse Interactive license. Once this has been installed, you must also
install the Control Panel and CT Connect Media Gateway licenses.

➢ To install the Enghouse Interactive License:

1. Run the Envox License Utility application from C:\Program Files (x86)\Enghouse
Interactive\CP\CPLicensingUtility.exe.

2. Verify your System ID number and send it to AudioCodes.

Enghouse Interactive has two licenses that you need to install:

■ Control Panel License

■ CT Connect Media Gateway License

Installing Control Panel License

Once you have received your Control Panel license back from AudioCodes, see
Installing Enghouse Interactive License above Paragraph Verify your System ID
number and send it to AudioCodes. above , and continue with the following
procedure.

➢ To install the Control Panel License:

1. Copy the licenses to C:\NSC\License\.

2. Run the Envox License Utility application from C:\Program Files (x86) \Enghouse
Interactive\CP\CPLicensingUtility.exe.

3. On the Enghouse Interactive CP Licensing Utility screen, click Load license.
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4. Browse to the license file location, and then select the CP_import.XML license file.

5. Click Open.

6. On the Enghouse Interactive System Information screen, click Apply License;
a confirmation message box appears informing you that the license has been applied
successfully.

7. Click OK.
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Installing CT Connect Media Gateway License

Once you have received your CT Connect Media Gateway license back from AudioCodes (see
Installing Enghouse Interactive License ), verify your System ID number, and then send it to your
AudioCodes representative. Continue with the following procedure.

➢ To install the CT Connect Media Gateway License:

1. Copy the Enghouse CT Connect Media Gateway License XML file to
C:\Program Files (x86)\Enghouse Interactive\CTI Connect\Licenses.

The filename must be named import.xml.

2. Restart the server to complete the license installation.

Installing Text-to-Speech Engine
The following describes how to install the Acapela Text to Speech engine.

Acapela non-Hebrew Text to Speech

● This installation is only applicable for non-Hebrew text to speech.
● The license key is dependent on your server's MAC address.

➢ To install the Acapela Text-to-Speech license:

1. Verify the server MAC address.

a. Enter "cmd" in the Run dialog box, and then click OK.
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b. Enter "ipconfig/all".

2. Find the Intel<R> 82579LM Gigabit Network Adapter, and then send the MAC address
(“Physical Address”) to AudioCodes.

3. AudioCodes will send you the license key.

4. Open the Windows Start menu, and then in the 'Search' field, enter "Acapela TTS Server
Control Center”.

5. Select it in the Search results.

- 42 -



CHAPTER 7    Installing Third-Party Licenses Voca | Installation Manual

6. On the Acapela TTS Server Control Center screen, click Server configuration.

7. Under the License System/Key Device group, selectMACIDKEY.

8. Copy the received license key into the key string field.

9. Click Apply, and then OK.

10. Configure the Acapela Telecom TTS Service:

a. Open Administrative Tools > Services.

b. Open Acapela Telecom TTS Service Properties.

c. From the 'Startup type' drop-down list, select Automatic.

d. Click Start.

e. Click OK.
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8 Configuring SBC Settings for Voca
This section describes how to configure the Voca, on the SBC side.

■ Coder Settings

■ Voca IP Profile Settings

● Delayed Offer SDP settings

● SIP UPDATE Support Settings

● Remote re-INVITE Settings

■ Terminate OPTIONS Request

■ Alternate Routing Settings

■ SIP Contact Header

■ SBC IP-To-IP configuration

■ Call Queue configuration

Coder Settings
Voca only supports G.711U-law and G.711A-law coders.

These coders should be configured in the Allowed Audio Coder Group in the IP Profile of the
Voca SIP entity on the SBC.

If the PBX system doesn’t support G.711U-law and/or G.711A-law coders, i.e., the coders do
not exist in the SDP offer of the incoming SIP message, the coders should be configured in
Extension Coders Group in the IP Profile of the Voca SIP entity.

Voca IP Profile Settings
Delete this text and replace it with your own content.

Delayed Offer SDP Settings

Voca doesn’t support incoming SIP messages without the SDP offer.

If an incoming SIP message doesn’t have the SDP offer, the 'Remote Delayed Offer Support'
field should be set as Not Supported in the IP Profile of the Voca SIP entity.

For the Remote Delayed Offer Support function, you need to assign extension coders
in the IP Profile of the Voca SIP entity as discussed above.

SIP UPDATE Support Settings

This configuration applies if the route is direct to Voca and not to the Voca Cloud SBC.
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Voca does not support incoming SIP UPDATE messages. In the IP Profiles of the Voca SIP entity,
from the 'Remote Update Support' drop-down list, select Not Supported.

Remote re-INVITE Settings

This configuration applies if the route is direct to Voca and not to the Voca Cloud SBC.

Voca does not support incoming SIP UPDATE messages. In the IP Profiles of the Voca SIP entity,
from the 'Remote re-INVITE ' drop-down list, select Not Supported.

Terminating SIP OPTIONS Requests
To terminate SIP OPTIONS messages at the SBC device (i.e., to handle them locally), create a
routing rule with the following settings:

Source IP Group: ANY

Request Type: OPTIONS

Destination Type: Dest Address

Destination Address: Internal

Alternative Routing Settings
When Voca does not respond, or responds with a SIP error, create the alternative routing
settings and redirect the call to customer’s extension.

SBC IP-to-IP Configuration
The following describes SBC configuration for routing calls to and from Voca:

■ Voca to One Node Routing Scenario: In this scenario, the system has only one Group ID
node of the customer’s side and one Voca server. You need to create two-way routing
between the customer and Voca nodes.

Sending DNIS Instead of Caller Number During Advanced Transfer

By default, Voca sends Caller CLI numbers during Advanced Transfer in from the header of the
INVITE message. Sometimes, the remote customer’s side does not accept this number (e.g., SIP
trunk Twilio). The remote customer's side accepts any number that belongs to the SIP trunk
DNIS pool.

Typical Scenario

■ The call from customer’s infrastructure arrives at the SBC.

■ The SBC adds the <X-SendDNIS:1> SIP header.
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■ After recognition, Voca puts the caller on hold and starts the Advanced Transfer.

■ Voca recognizes the header value and sends the DNIS number in the From Header of the
INVITE message.

If the <X-SendDNIS> header does not exist or is empty, then Voca sends the Caller
CLI number. If the <X-SendDNIS> header has any value, then Voca sends the DNIS
number.

Configuring the SBC

The procedure below describes how to configure the SBC for this feature.

➢ To configure the SBC:

1. Add the <X-SendDNIS:1>Message Manipulation (Message Manipulation >Message)
header.

2. In the Inbound Message Manipulation of the Twilio SIP IP Group, add the 'Manipulation Set
ID'.

Changing REFER with Replaces to Simple REFER Message

By default, Voca sends 'REFER with Replaces' during Advanced Transfer. If customer’s side
doesn’t support 'REFER with Replaces', you need to manipulate it to a simple REFER message.
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Configuring the SBC

The procedure below describes how to configure the SBC for this feature.

➢ To configure the SBC:

1. Create the Message Manipulation (Message Manipulation >Message Manipulation).

Header.Refer-To regex (.*)(Replaces)(.*)

Header.X-AC-Action 'use-config;refer-behavior=handle-locally'

2. Assign this manipulation set as an Inbound Message Manipulation Set in the Voca IP Group.

SIP Contact Header
When using attended transfer, Voca is using the Contact header to send the call back to the
sender (SBC). Sometimes, the remote customer’s side sends the Contact header with
parameters that can interfere with the attended transfer. It is important that the Contact
header contains only necessary information.

The following is an example of a Contact header arriving from Teams:

The marked information needs to be removed to send the call back to the sender.

CONTACT: <sip:api-du-c-euwe.pstnhub.microsoft.com:443;x-i=02eb7942-64b8-
40be-a784-5eada3b177bd;x-
c=6dd9cd1c7413507db3a275ef61fc2f2f/d/8/c7e1cdce609145f78d28c4886b57e2
63>

This is how it should appear after the manipulation:

CONTACT: <sip:api-du-c-euwe.pstnhub.microsoft.com:443>
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The following configuration is based on Port 443 (this port needs to be changed if the sender
uses a different port).

SBC Configuration

The procedure below describes how to configure the SBC for this feature.

➢ To configure the SBC:

1. Add the Message Manipulation (Message Manipulation >Message).

2. In the 'Inbound Message Manipulation Set' field of the SIP IP Group that the call is routed
from, add theManipulation Set ID.

Call Queue Configuration
The procedure below describes how to configure Call Queues.

➢ To configure Call Queues:

1. Enable Music on Hold on the Enghouse Control Panel.

2. Configure the SBC to support call queues.

3. Create a dummy call to a '99999' number during the call queue procedure.

4. Terminate this dummy call on the SBC.
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9 Installing Signed Certificates on the IIS
To configure Voca to work with HTTPS, you must first install a valid signed certificate.

Use the following procedures to install the certificate on the Internet Information Server (IIS).

Managing Certificates in the MMC Snap-in
You can manage certificates in the MMC Snap-in.

➢ To manage certificates in the MMC Snap-in:

1. Open the Command Prompt window.

2. EnterMMC and then press ENTER.

To view certificates in the local machine store, you must be set up as an
Administrator.

3. On the Console Root, click File > Add/Remove Snap.
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4. From the File menu, choose Add/Remove Snap In.

5. In the 'Available snap-ins', select Certificates.

6. Click Add > to add snap-ins.
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7. In the Certificates snap-in group, click the Computer Account option, and then click Next.

You can select either My user account or Service account options. If you are not
an Administrator of the computer, you can manage certificates only for your user
account.

8. Click the Local computer option.

9. In the Select Computer dialog box, click Finish.

10. In the Add/Remove Snap-in dialog box, click OK.
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11. In the Console Root window, click Certificates (Local Computer) to view the certificate
stores for the computer.

12. To view certificates for your account, repeat steps 3 to 6. In step 7, instead of selecting
Computer account, clickMy User account and repeat steps 8 to 10 (Optional step).

13. From the Filemenu, choose Save or Save As. Save the console file for later reuse (Optional
step).

Adding a Certificate
1. Navigate to Console Root > Certificates (Local Computer) > Personal > Certificates.

2. On right pane, select All Tasks > Import.

3. Follow the dialog to install the certificate.

Selecting a Certificate in IIS Manager
You can select a certificate in the Internet Information Services (IIS) Manager.

➢ To select a certificate in IIS Manager:

1. Open the IIS Manager.
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2. Right-click the default site, and then choose Edit Site – Bindings.

3. Select HTTPS binding (Port 443), and then click Edit.

4. From the 'SSL certificate' drop-down list, select the new certificate, and then click OK.
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10 Enabling .NET Framework 3.5 on Windows
You can use Server Manager to enable .NET Framework 3.5. For more information, see
Microsoft’s guidelines here.

Before enabling .NET Framework 3.5, ensure that you have the following:

■ Windows Server 2016

■ Administrator user rights. The current user must be a member of the local Administrators
group to add or remove Windows features.

■ Target computers might need network access and rights to use either alternate sources or
an Internet connection to use Windows Update.

■ Installation media (only if you have no Internet connection to use Windows Update)

➢ To enable .NET Framework 3.5 on a Windows System:

1. On the Server Manager page, clickManage, and then select Add Roles and Features to
start the Add Roles and Features Wizard.

2. On the Before you Begin page, click Next.
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3. On the Select Installation Type page, click the Role-based or feature-based installation
option, and then click Next.

4. On the Selection Destination Server page, select the target server, and then click Next.
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5. On the Select Server Roles page, click Next.

6. On the Select Features page, select the '.Net Framework 3.5 Features' check box, and then
click Next.
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7. On the Confirm Installation Selections page, click Install.

On the Confirm Installation Selections page, a warning is displayed asking Do you
need to specify an alternate source path?. If the target computer does not have
access to Windows Update, click the Specify an alternate source path link to spe-
cify the path to the \sources\sxs folder on the installation media and then clickOK.
After you have specified the alternate source, or if the target computer has access to
Windows Update, click the X next to the warning, and then click Install.
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11 Configuring WebRTC
WebRTC is an AudioCodes SBC feature and allows up to three concurrent WebRTC sessions, as
part of the AudioCodes SBC license.
For support of more sessions, contact your AudioCodes representative.

For more information, you can download the following:

■ Mediant Software SBC User's Manual

■ Adding Click-to-Call Widget to an Existing Web Page (video)
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12 Upgrading from Voca 8.0.2 to 8.4.0 Enghouse CTIC
(Media Gateway) Application
The Enghouse CTIC (Media Gateway) application is removed by the installer during the upgrade
procedure from Voca 8.0.2 to 8.4.0.

The procedure below describes how to install and configure the Enghouse CTIC (Media
Gateway) application.

Backup the CTIC (Media Gateway) license before running the upgrade procedure.
The license can be found in C:\Program Files (x86)\Enghouse Interactive\CTI
Connect\Licenses.

➢ To install and configure the Enghouse CTIC (Media Gateway) application:

1. Assign the IP address of the Voca server in the MG configuration file template. The
C:\Voca_8.4.0\Enghouse CTIC\CTC_MG_Conf\conf\vars.xml file is copied by the script in
the MG directory after the installation procedure.

2. Right-click on the C:\Voca_8.4.0\Enghouse CTIC\CTI_Connect_Install.bat file and then
select Run as Administrator.
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3. Wait for the installation to finish.

4. Assign the Voca user credential to the following services:

● Enghouse Interactive CTI Connect Server

● Enghouse Interactive Media Gateway
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5. Copy the license file to C:\Program Files (x86)\Enghouse Interactive\CTI Connect\Licenses.

6. Restart the server.

- 65 -



CHAPTER 13    Upgrading from Voca 8.0.1 to 8.4.0 Voca | Installation Manual

13 Upgrading from Voca 8.0.1 to 8.4.0
The upgrade procedure fails when you try to upgrade Voca 8.0.1 (primary or secondary) to 8.4.0
(primary or secondary).

This does not occur when upgrading from Voca 8.0.1 (standalone) to 8.4.0 (standalone).

➢ To fix this upgrade problem:

1. Unzip and install Orca MSI editor C:\Voca_8.4.0\DLL Fix - 8.0.2\.

2. Open C:\Windows\Installer\.

3. Right-click on the Name column, and then clickMore.

4. Select the 'Subject' check box, and then click OK.
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5. Arrange the files by size, and then find the file with the Voca subject name.

6. Right-click on this file, and then select Edit with Orca.

The filename may be different than the one on the screen.

7. Find the Binary table.

8. Find PswManagedCA.X64.dll, and then double-click Binary Data.
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9. Select the Choose Read binary from filename option.

10. Browse to the C:\Voca_8.4.0\DLL Fix - 8.0.2/PswManagedCA.X64.dll, and then click OK.

11. Click OK to overwrite the contents of the stream.

12. Do the same editing for PswManagedCA.X86.dll and PanelSwCustomActions.dll.
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13. Find the PSW_InstallUtil table, and then set 'Bitness' to "2" for all services.
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14. Save and close the Orca editor.

15. Run the Voca Version 8.4.0 upgrade procedure.
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14 Completing the Upgrade to Voca 10
Once you have upgraded to Voca Version 10, apply the following FastGGI settings of the IIS.

The following settings should only be applied after you have upgraded to Version 10.

The procedure below describes how to apply the FastCGI settings.

➢ To apply the FastCGI settings:

1. Open the Internet Information Services (IIS) Manager in Administrative Tools.

2. On the right-pane, click IIS Connections.

3. Double-click on FastGGI Settings.

4. Right-click on PHP Full Path, and then from the drop-down menu, select Edit.
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5. Click Advanced Settings, and then in the FastCGI Properties group, from the 'Protocol' field
drop-down list, select Tcp.

6. Click OK.

7. Close the IIS Manager, and then restart the server.

- 72 -



CHAPTER 15    Enabling Music on Hold on Enghouse Control Panel Voca | Installation Manual

15 Enabling Music on Hold on Enghouse Control
Panel
Music On Hold (MOH) is a feature that plays a recording of music when consultation transfers
take place.

➢ To enable Music on Hold:

1. Verify the Enghouse Communication Portal version.

2. Open the Enghouse Control Panel.

3. Click Help, and then click About Enghouse Interactive CP Console. The following appears:

4. From the Enghouse Communication Portal 10.4, copy the MOH.wav file to the
C:\ProgramData\Enghouse Interactive\Media Gateway\Sounds folder.

5. From the Enghouse Communication Portal 10.6, copy the MOH.wav file to the C:\Program
Files (x86)\Enghouse Interactive\CP\Data folder.
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6. On the right-pane of the Enghouse Control Panel, open theMedia Gateway Driver
properties and then, in the 'Transfer Music-on-Hold' field, enter the filename.

7. Right-click the server's name, and then click Restart CP Engine(s).
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4. From the Restart Engine(s) options, select Terminate and restart Engine(s), and then click
OK.

8. In response to the following question, click Yes.
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16 Configuring Voca High Availability
The procedure below describes how to configure Voca High Availability.

➢ To configure Voca High Availability:

1. Stop PLM and Enghouse services.

2. Stop MySQL service on both servers.

3. Copy C:\NSC\MYSQLServer\data from the Primary node to the Secondary node.

4. On the Secondary node, remove the\data\auto.cnf file.

5. Copy the following, and paste at the end of C:\NSC\MYSQLServer\my.ini on the Primary
node.

server-id=1

log-bin=mysql-bin

relay-log=mysql-relay-log

auto-increment-increment=2

auto-increment-offset=1

binlog-do-db=seda

binlog-do-db=seda_logs

replicate-do-db=seda

replicate-do-db=seda_logs

replicate-ignore-table=seda.vn_cluster_node_parameters

binlog-format = MIXED

expire_logs_days = 30

sync_binlog = 1

max_binlog_size = 52428800

6. Copy the following and paste at the end of C:\NSC\MYSQLServer\my.ini on the Secondary
node.

server-id=2

log-bin=mysql-bin

relay-log=mysql-relay-log

auto-increment-increment=2

auto-increment-offset=2

binlog-do-db=seda

binlog-do-db=seda_logs

replicate-do-db=seda

replicate-do-db=seda_logs

replicate-ignore-table=seda.vn_cluster_node_parameters

binlog-format = MIXED
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expire_logs_days = 30

sync_binlog = 1

max_binlog_size = 52428800

7. Start MySQL service on both servers.

8. Open MySQL Workbench and connect as ROOT in both servers.

9. Run the following on both servers:

create user 'replicator'@'%' identified by '1q2w3e$r';

grant replication slave on *.* to 'replicator'@'%' identified
by '1q2w3e$r';

GRANT REPLICATION CLIENT ON *.* to 'seda'@'localhost';

10. Run the following on the Primary server:

show master status;

use output value master_log_file and position in the next step

For example:
master_log_file='mysql-bin.000001'

master_log_pos=704

11. Run the following on the Secondary node:

stop slave;

Assign the IP address of the Primary node and output information in the next com-
mand:

change master to master_host='10.31.5.240',master_
user='replicator',master_password='1q2w3e$r',master_log_
file='mysql-bin.000001',master_log_pos=704;

show master status;

Use output value master_log_file and position in the next step

For example:
master_log_file='mysql-bin.000001'

master_log_pos=704

12. Run the following on the Primary node:

stop slave;

Assign the IP address of the Secondary node and output information in the next com-
mand:
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change master to master_host='10.31.5.245',master_
user='replicator',master_password='1q2w3e$r',master_log_
file='mysql-bin.000001',master_log_pos=704;

13. Run the following on both nodes:

start slave;

14. Start PLM and Enghouse services.

15. Assign the following settings in the seda.vn_cluster_nodes table:
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